Time Matters® and Billing Matters® 11.1

User Guide
About this guide

This guide provides steps to achieve basic, commonly performed tasks. For additional details, including interface elements and advanced tasks, see the Time Matters® Help.

Copyright and Trademark

LexisNexis, Lexis, and the Knowledge Burst logo are registered trademarks of Reed Elsevier Properties Inc., used under license.

Time Matters and Billing Matters are registered trademarks of LexisNexis, a division of Reed Elsevier Inc.

Other products and services may be trademarks or registered trademarks of their respective companies.

Copyright 2012 LexisNexis, a division of Reed Elsevier Inc. All rights reserved.

Version 2012.02.14.11.03

LexisNexis
2000 Regency Parkway
Suite 600
Cary, North Carolina USA 27518

North America: 800.387.9785
Outside North America: 919.467.1221
Fax: 919.467.7181

Contents

Login and Password Assistance ................................................................. 1
Start Time Matters ....................................................................................... 1
Log in ............................................................................................................ 1
Use Training Mode to practice using Time Matters ................................... 1
Obtain a forgotten password ...................................................................... 1
Change a password .................................................................................... 1
Tour of the interface .................................................................................. 3
Use the Navigator to open program features ............................................ 3
View a list of records .................................................................................. 4
Locate a record on a list ............................................................................ 5
Open a record for viewing or editing ......................................................... 5
Clients and Contacts ................................................................................ 6
View a Contact .......................................................................................... 6
Create a Contact using the wizard ............................................................ 7
Create a Contact when the wizard is disabled ......................................... 12
Edit a Contact .......................................................................................... 13
Delete a Contact ....................................................................................... 14
Matters ....................................................................................................... 15
View a Matter ............................................................................................ 15
Create a Matter using the wizard .............................................................. 15
Create a Matter when the wizard is disabled .......................................... 20
Edit a Matter ............................................................................................ 21
Delete a Matter ......................................................................................... 22
Associate a Contact with a Matter ......................................................... 23
Calendars .................................................................................................. 24
Customize the calendar view ................................................................... 24
Create an event using an event form ...................................................... 25
Edit a calendar event ............................................................................... 26
Delete a calendar event ........................................................................... 26
Create a ToDo calendar item ................................................................... 27
Mark a ToDo calendar item as completed ............................................. 29
Documents ............................................................................................... 30
Save a document to Time Matters from Microsoft Word or Corel WordPerfect ................................................................. 30
Create a document record for an existing file ....................................... 30
Add a document to an existing record ................................................... 31
Create a new document using the formattable clipboard ....................... 33
Design a formattable clipboard ................................................................. 34
Create a new version of an existing document .................................. 36
Communications ..................................................................................... 37
View your email ....................................................................................... 37
Create and send email ........................................................................... 37
Send instant messages to other Time Matters users ............................... 38
Create a phone record ............................................................................ 38
# Reports

- Print a standard report ................................................................. 40
- Export information to an Excel spreadsheet ................................ 40
- Save a tagged list ........................................................................ 42
- Design a report ............................................................................ 43
- Edit a report ................................................................................ 49
- Print labels .................................................................................. 50
- Print envelopes ........................................................................... 53

## Time & Expense

- Create a timesheet ....................................................................... 55

## Billing

- Set up basic billing ..................................................................... 56
- Add and print an invoice .............................................................. 57
- Print multiple invoices ................................................................. 59
- Print a pre-bill from the Billing menu ......................................... 59
- Create a bill ................................................................................. 60
- Post/undo a bill .......................................................................... 60
- Receive a payment ...................................................................... 61
- Record a bank deposit ................................................................. 62

# User Preferences

- Set user preferences .................................................................. 63
- Enable or Disable the Wizard ..................................................... 64
- Customize the Time Matters main toolbar ............................... 64
- Customize a Time Matters list toolbar ...................................... 66
Login and Password Assistance

Start Time Matters

To start Time Matters, go to Start > All Programs > LexisNexis > Time Matters 11.0, or click the Time Matters icon on your desktop.

Log in

1. Launch Time Matters.
2. Enter your User ID.
3. Enter your password.
4. Click OK.

Use Training Mode to practice using Time Matters

Training Mode lets you use sample data to learn the features of Time Matters. When you log in using Training Mode, none of your actions affect your firm’s real data.

To open Time Matters in Training Mode:

1. Click the Windows Start menu, click All Programs, point to LexisNexis, and click Training Mode - Time Matters 11.0. The Update Sample Data window opens.
2. Select Reload, Update, or Cancel when asked whether you want to update sample data. The Login Information window opens.
3. Click OK. The login window opens.
4. Enter TM as the user ID and TM as the password.
5. Click OK.

Obtain a forgotten password

Contact your Time Matters administrator.

Change a password

Note: Your Time Matters user account must have permission to access the Security Setup screen.

1. Launch Time Matters.
2. Expand the File menu, and then select Setup, then User and Security, then Users.
3. The Security Setup window displays. Double-click the user’s record to be changed.
4. Under the **General** tab, enter a new password and confirm it in the **Password** and **Confirm** fields.

5. Click **OK** to save your change.
Tour of the interface

Use the Navigator to open program features

The Navigator provides quick access to the most-used features of Time Matters.

To use the Navigator:

1. If the Navigator is not already open, or if other windows are covering the Navigator, click the View menu and then click Navigator. (You can also click the Navigator button on the main toolbar, or press CTRL+N.)

2. Click one of the tabs on the left side of the Navigator. Each tab displays a different collection of buttons in the main area of the Navigator.

3. Click a button on the Navigator to open that Time Matters feature.
View a list of records

Each record type (such as Contacts, Matters, and Documents) has its own record list. The list is often the most convenient place to locate specific records and view summary information about them.

Although most types of record lists can be accessed from the Database menu, others are accessed from other menus.

To view a list of...

- **Contacts**: Click the Database menu, point to Contact List, and click All Contacts.
- **Matters**: Click the Database menu, point to Matter List, and click All Matters.
- **Events**: Click the Calendar menu, point to Event List, and click All Events.
- **ToDo’s**: Click the Calendar menu, point to ToDo List, and click All ToDo’s.
- **Documents**: Click the Database menu, point to Document List, and click All Documents.
- **Notes**: Click the Database menu, point to Note List, and click All Notes.
- **Email**: Click the Mail menu, point to Email List, and click All Email.
- **Mail**: Click the Mail menu, point to Mail List, and click All Mail.
- **Phone Calls**: Click the Database menu, point to Phone Call List, and click All Phone Calls.
- **Billing Items**: Click the Billing menu, point to Billing Item List, and click All Billing Items.
- **Custom Forms**: Click the Database menu, point to Custom Form List, and click All Custom Forms.
- **Lexis Research Records**: Click the Database menu, point to Lexis Research, and click All Lexis Research.
- **Outlines**: Click the Database menu, point to Outline List, and click All Outlines.
- **Vendors**: Click the Database menu, point to Vendor List, and click All Vendors.
- **User Defined Records**: Click the Database menu, point to <user defined name> List, and click All <user defined name> Types.
Locate a record on a list

Time Matters provides several ways to locate a specific entry on a record list. Two simple methods are using QuickPik and the Search box on the list toolbar.

To use QuickPik:

1. Click the header of the column you want to search on.
2. Type the first few characters of the word or number you want to find.
   
   The record that most closely matches what you are typing will be highlighted in the list.

To use the Search box:

1. Click inside the Search box on the list toolbar.
2. Type a word, name, or number associated with the record you want to find.
3. Press ENTER.
   
   The list will be filtered to display only records that match the text you typed.

Open a record for viewing or editing

1. Open the list of the record type you want to view.
2. Double-click the record you want to view or edit. The record form opens.
3. Click the tabs below the record form toolbar to view additional information about the record and lists of other records related to it.
Clients and Contacts

View a Contact

1. Launch Time Matters.
2. Click the Contacts button in the toolbar.
3. A contact window displays. The window contains a list of contacts.
4. Highlight the record for which you want to view more detailed information.
5. Note that a power view is displayed on the right of the window. This contains basic information about the contact.
6. The information displayed in the power view can be selected using the power view drop down box.
7. To see an entire contact record, double-click the contact record in the list.
Create a Contact using the wizard

A Contact is any person or organization about which your firm has collected information. If you do not know all of the information for a contact, you can create the contact with minimal data, and then add details later.

1. Launch Time Matters.
2. Expand the File drop down menu, and then select New Record, then Contact.
3. Note that the first display is the Introduction step of the New Contact setup. Select the person or organization option button.
4. Enter, or select, a code. Click the down arrow to select a single code from existing codes, or click the lookup button to select multiple codes.
5. Enter a unique number for this client.
6. Click to check Billable, if applicable.
7. Click **Next** to continue with setup.

8. Note that the appearance of the **Person** or **Organization** view varies, depending on the type of contact selected on the previous view. For the purpose of this example Person has been selected, therefore, the next step is to enter a **Ref Name** (the name that appears in lists of contacts).

9. Fill in the available information about the contact’s name. The available fields are **Last**, **First**, **Sal**, **Pre**, and **Suf**. You may not have information for every name field. If applicable, enter the contact’s last name in the **Last** field; first name in the **First** field; a salutation, such as Jr, in the **Sal** field; a prefix, such as Dr, in the **Pre** field; and a suffix, such as PhD, in the **Suf** field.

10. Enter a firm name or employer in the **Firm** field.

11. Enter a title in the **Title** field, if applicable.

12. Enter a website for the contact, if applicable.
13. Click **Next** to continue with setup.

![Create a New Contact - Phone Numbers]

14. The **Phone** view window displays. Enter the main telephone number for the contact in the **Main** field, if one is available. If not, it can be filled in later or it can be left blank.

15. Enter an alternate telephone number for the contact in the **Alt** field, if one is available. If not, it can be filled in later or it can be left blank.

16. Enter the FAX number for the contact in the **FAX** field, if one is available. If not, it can be filled in later or it can be left blank.

17. Enter the cell and/or pager numbers for the contact in the **Cell/Pager** field, if either is available. If not, either can be filled in later or left blank.
18. Click **Next** to continue with setup.

19. The **Address** view window displays. Enter a firm name or employer in the **Firm** field. This will be pre-populated if you previously entered this information.

20. Enter a title in the **Title** field. This will be pre-populated if you previously entered this information.

21. Enter a full address for the contact, if it is available.

22. Enter an email address for the contact, if it is available.
23. Click **Next** to continue with setup.

![Image of the New Contact Intake window]

24. On the final view window of the New Contact setup, indicate whether you would like to view the completed contact form once your changes are saved. The default is to view the record.

25. **Save** your changes.
Create a Contact when the wizard is disabled

1. Launch Time Matters.
2. Expand the File menu, and then New Record then click Contact.
3. The Contact Form – Add form displays. Since a contact may be a person or an organization, an adjustment in the data field labels can be made. Click the button that says Full Name and it changes to Org Name. Click it again to change it back to Full Name.

4. If the Contact is a client, type a number in the ClientNo field.
5. Select, or enter, a classification code in the Code field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected. These codes describe different categories of contacts, such as clients, attorneys, accountants, or corporations.
6. Enter the remaining information for the contact. Note that although there are several tabs on the form, completing the Primary tab often provides sufficient information about a contact.
7. Click Save & Close to save your changes and close the Contact form.
**Edit a Contact**

1. Launch Time Matters.
2. Click the **Contacts** button in the toolbar.
3. A contact list displays. The window contains a complete list of contacts.
4. Right-click the record to be edited. A menu containing the possible actions you can take displays. Select Change Record (or press the Enter key).
5. A contact form displays. Edit the contact information as needed. Note that there are a number of tabs containing information. Click the tab name to open its form.
6. Use the double arrows on the tab line to display additional record tabs.
7. **Save** your changes.
Delete a Contact

1. Launch Time Matters.
2. Click the **Contacts** button in the toolbar.

3. A contact list displays. The window contains a complete list of contacts.
4. Right-click the record to be deleted. A menu containing the possible actions you can take displays. Select Delete Record (or press the Delete key).

5. You will be asked to verify that you want to remove the contact record. If you do, select Yes. If you do not want to remove the record, select No.

6. Note that the record is no longer displayed on the list of contacts.
Matters

View a Matter

1. Launch Time Matters.
2. Click the Matters button in the toolbar.
3. A matters list displays. The window contains all stored information about matters.
4. Highlight the record in the center list for which you want to view more detailed information.
5. Note that a power view is displayed on the right of the window. This contains basic information about the highlighted matter.
6. The information displayed in the power view can be selected using the power view drop down box.
7. To see an entire record for a matter, double-click the matter record in the list.

Create a Matter using the wizard

Create a Matter record when you need to collect and record information about a new case, project, or job that you perform for a client. The Matter record stores information about all the parties involved in the Matter and provides lists of other records linked to the Matter. Changes can be made to the matter information after the matter is created.

1. Launch Time Matters.
2. To create a Matter, expand the File drop down menu, and then select New Record, then select Matter.
3. Note that the first display is the **Introduction** step of the matter setup.

![Introduction step of matter setup](image)

4. Enter a description of the matter in the **MatterRef** field. This field is required. It indicates how your firm categorizes the matter internally.

5. Enter a matter number in the **MatterNo** field. This is generally a number from your firm’s internal numbering system, or the court case number. In some cases, your system administrator may have set up automatic generation of this number. If that is the case, the number will be pre-populated.

6. Enter the jurisdiction for the matter in the **Court** field.

7. Select, or enter, a classification code in the **Code** field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected.

8. Indicate whether the matter is billable in the **Billable** field.
9. Click **Next** to continue setup.

10. Select the attorney assigned to this matter, if applicable, in the **Staff** field.

11. Select the plaintiff for this matter, if applicable, in the **Plaintiff** field. The information for the plaintiff should have been entered previously as a contact. Use the lookup button to make your selection from the list of existing contacts.

12. Select the defendant for this matter, if applicable, in the **Defendant** field. The information for the defendant should have been entered previously as a contact. Use the lookup button to make your selection from the list of existing contacts.

13. Select the client for this matter, if applicable, in the **Client** field. The information for the client should have been entered previously as a contact. Use the lookup button to make your selection from the list of existing contacts.
14. Click **Next** to continue setup.

15. Select the name of the individual that you deal with most frequently for this matter in the **Pri Contact** (primary contact) field. This individual should have been entered previously as a contact. Use the lookup button to make your selection from the list of existing contacts.

16. The firm name will auto-fill the **Firm** field, if the information is available for the selected contact.

17. The address will auto-fill the **Address** field, if the information is available for the selected contact.

18. The telephone and FAX numbers will auto-fill the **Tel/FAX** field, if the information is available for the selected contact.
19. Click **Next** to continue setup.

20. Select the name of the opposing attorney for this matter in the **Opp Atty** field. This individual should have been entered previously as a contact. Optionally, use the lookup button to make your selection from the list of existing contacts.

21. The firm name will auto-fill the **Firm** field, if the information is available for the selected contact.

22. The address will auto-fill the **Address** field, if the information is available for the selected contact.

23. The telephone and FAX numbers will auto-fill the **Tel/FAX** field, if the information is available for the selected contact.
24. Click **Next** to continue setup.

25. Indicate whether you would like to view the completed matter form once your changes are saved.

26. **Save** your changes.

**Create a Matter when the wizard is disabled**

1. Launch Time Matters.

2. Expand the **File** menu, and then **New Record** then click **Matter**. The Matter Form - Add window opens.

3. Type a name and number for the Matter in the MatterRef and MatterNo fields, respectively.

4. Select, or enter, a classification code in the **Code** field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected. These codes describe different categories of Matters, such as bankruptcy, civil, and estate planning.

5. If the Matter is to be billable, select the Billable check box.

6. Enter the remaining information for the Matter. Note that although there are several tabs on the form, completing the **Primary** tab often provides sufficient information about a Matter.

7. **Click Save & Close** to save your changes and close the Matter form.
Edit a Matter

1. Launch Time Matters.

2. Click the **Matters** button in the toolbar.

3. A matters list displays. The window contains a complete list of matters for your firm.

4. Right-click the record to be edited. A menu containing the possible actions you can take displays. Select Change Record (or press the Enter key).

5. A matter form displays. Edit the matter information as needed. Note that there are a number of tabs containing information. Click the tab name to open its form.

6. Use the double arrows on the tab line to display additional record tabs.

7. **Save** your changes.
Delete a Matter

1. Launch Time Matters.

2. Click the Matters button in the toolbar.

3. A matters list displays. The window contains a complete list of matters for your firm.

4. Right-click the record to be deleted. A menu containing the possible actions you can take displays. Select Delete Record (or press the Delete key).

5. You will be asked to verify that you want to remove the matter record. If you do, select Yes. If you do not want to remove the record, select No.

6. Note that the record is no longer displayed on the list of matters.
Associate a Contact with a Matter

There are many ways to establish a connection between a contact and a matter.

1. Launch Time Matters.

2. Display a contact form. Enter, or select, the matter’s reference identifier in the **MatterRef** field on the contact form. If necessary, use the Matter Lookup button to display a list of matters. This field can be completed at the time the contact is created, or the contact can be edited later.

3. Display a Matter form. To connect a Matter to a contact, enter, or select an entry in the **Client** field on the Matter form. If necessary use the Contact Lookup button to display a list of contacts. This field can be completed at the time the matter is created, or the matter can be edited later.

4. **Save** your changes.
Calendars

Customize the calendar view

Your calendar can be customized to meet your needs and preferences.

1. To access the calendar, launch Time Matters.
2. Expand the Calendar menu, and then select Daily Calendar to see a daily view.
3. There are 3 types of daily views; Daily, 3 days, or 5 days. A weekly view and a monthly view are also selectable. Click the view button you prefer to use to view and add calendar items. With all 3 daily views, the calendar is divided into events, ToDos, the Reference Calendar, and Supporting Records.

4. Click the Scheduler button to see events and tasks that have been created for that day.

5. Select the date to be viewed in the GoTo drop down menu field.
6. Select the contact, whose calendar you want to view, using the contact drop down menu.
7. Click the Options button to modify your view. Note that any preferences that are selected will modify only the calendar view and do not change the event or ToDo form.
Create an event using an event form

Events are generally meetings, conferences, or appointments for which there is a specific date and time. An event form should be used to create calendar events for which the purpose and participants should be recorded.

1. Launch Time Matters.

2. To display the calendar in daily view, click the **Calendars** icon, and then select **Daily** from the drop down menu. The Daily calendar opens.

3. Right-click the proposed timeslot on the day that event is to be scheduled.

4. Select **Add Record** from the popup menu.

5. An **Event Form** opens. The date and start time are pre-populated.

6. Enter the amount of time the event will require in the **Duration** field. The time lookup button may be used.

7. Select, or enter, a classification code in the **Code** field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected.

8. Enter an event description in the **Description** field.
9. It is recommended that reminders be set up. To set up reminders, enter the number of days before the event that the first reminder should be sent. Multiple days can be set if you would like to send multiple reminders. For example, if reminders should be sent starting 3 days before the event, and again 2 days before the event and one day before the event, enter “3, 2, 1” in the Reminder field. Remember to separate the number of days by a comma.

10. Enter information about who will be attending the event in the Staff field. Complete the event form as needed for your event.

11. Save your changes. The event will be displayed on the calendar.

**Edit a calendar event**

1. Launch Time Matters.

2. To display the calendar in daily view, click the Calendar icon, and then select Daily from the drop down menu. The Daily Calendar opens.

3. Click the event to activate it, and then right-click the event to be edited.

4. Select Change Record from the drop down menu.

5. An event form opens. Make the required change to the event.

6. Save your changes.

**Delete a calendar event**

1. Launch Time Matters.

2. To display the calendar in daily view, click the Calendar icon, and then select Daily from the drop down menu. The Daily Calendar opens.
3. Click the event to activate it, and then right-click the event to be deleted.

4. Select Delete Record from the drop down menu.

5. An event form opens, along with a screen asking for verification that the deletion should be completed.

6. Click **Yes** if the deletion should be completed.

7. **Save** your changes.

### Create a ToDo calendar item

A ToDo item is very similar to an event but it must be completed by a specific date, not by a specific time.

1. To create a ToDo item on a calendar, launch Time Matters.

2. To display the calendar in daily view, click the **Calendars** icon, and then select **Daily** from the drop down menu.

3. The calendar displays. On the **Reference** calendar, click the date by which the item must be completed.

4. Double-click anywhere in the **ToDo** section of the calendar.
5. The **ToDo** form opens.

6. Select a priority number in the **Priority** field. This determines the order in which the ToDo item will appear on the calendar.

7. Select, or enter, a classification code in the **Code** field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected.

8. Enter a brief description of the task in the **Description** field. This is the text that will be displayed on the calendar.

9. There are 4 pieces of information to be completed as part of the **Regarding** field. This set of information also appears on the Event, ToDo, and Supporting Forms. The Contact form has Matter Reference and Matter Number fields. The Matter form has Client and client Number fields. Completing this information is important to maintain relationships in the database. Also, completing these fields causes the record to appear on the Timeline Tab on the Contact and Matter records.

10. If one or more reminders should be sent, enter that information in the **Reminder** field. Note that if one of your reminders falls on a weekend or holiday, you will be prompted to change that reminder date so that it occurs on a workday.

11. If reminders should be sent until the ToDo is closed, click to check the **Follow** field. Enter any other information that is relevant to this ToDo item.

12. **Save** your changes. Your new ToDo item appears on the calendar and ToDo list.
Mark a ToDo calendar item as completed

1. Launch Time Matters.
2. Display the calendar in daily view.
3. Click the ToDo item to activate it, and then right-click the item to be marked as complete.
4. Select Mark As Done from the popup menu.
5. Note that the ToDo item is displayed with a strikethrough on the calendar.
Documents

Save a document to Time Matters from Microsoft Word or Corel WordPerfect

Although this example uses Microsoft Word, the TM Save function is available in Microsoft Office products, Corel WordPerfect, Internet Explorer, Mozilla Firefox, Adobe Acrobat, and Acrobat Reader.

1. Launch Time Matters.
2. In Microsoft Word, click the Add-ins toolbar item to access the TM Save button.

![Add-ins toolbar item](image)

3. The Add Document record opens.
4. Complete the required fields; **Code, Description, Staff, Matter**, and **Contact**. As the Matter is entered, the rest of the field fills in. Press the TAB key to fill in the rest plus file name.
5. Click **Save & Close** and the document is saved in the Document Management System.

Create a document record for an existing file

1. Open the file in a supported application (e.g., Word, Excel).
2. Click the **TM Save** button in the toolbar. If the button does not appear, and is not an available option when customizing the application toolbar, contact your system administrator.

![TM Save button](image)

3. Time Matters opens, possibly requiring that you log in.
5. Complete the form.
6. **Save** your changes. The document in your original file is now associated with Time Matters.
Add a document to an existing record

1. Launch Time Matters.
2. Open a list. For this example, click the Matters icon to open the Matters list.
3. The Matters list opens.
4. Double-click the matter to which a document is to be added.
5. A Matter Form for that matter displays. On the matter form window, click the Documents tab.
6. The documents associated with the matter are displayed at the bottom.
7. Click the Add new record button.
8. A Document Form displays. Note that the date and time are populated with the current date and time. Select, or enter, a classification code in the Code field. If you want to select multiple classification codes, use the lookup button.
9. Enter a name for the new document in the **Description** field.

10. Select the responsible staff in the **Staff** field.

11. The contact and record information is filled in automatically because the document record was started from within the matter. If that information is not available, complete the **Regarding** fields manually.

12. The **File Name** field is populated automatically according to the setting selected in Program Level Setup. If the file name does not populate as expected, contact your system administrator. Before you click the Create button below, verify that the expected information is displayed in the File Name field.

13. There are 8 customizable fields that can be used for any purpose needed. This could be an auto-incrementing document number, the initials of the typist, or keywords for searching later.

14. In area 4, you can create a new file using a document template, a clipboard or merge template to copy information from the contact or matter records, to scan directly from a TWAIN compliant scanner, or from a HotDocs template. To create, for example, a new Word document, click the **New File** button.

15. Click the **Data Source** button to verify that the record type from which data will be extracted, and the records listed are correct. If not, use the Add and Remove buttons to filter the list as needed.

16. Click the **Template** button and select a template from the displayed list. The correct extension will be displayed in the File Name field.

17. Once the Document Form is complete, click the **Create** button.

18. If a question verifying the directory creation is displayed, click **Yes** to proceed.

19. The word processor opens. Create your document.

20. Save your changes and close the word processor. The Document Form is still displayed.

21. Save and close the Document Form.

22. To revisit the document just created, click the Docs icon in the main toolbar.

23. A document list displays. Double-click the document record in the list.
24. The Document Form displays. Click the Go To button. To see a newer version, if one exists, click the **New Version** button.

25. The word processor opens and the document is displayed.

**Create a new document using the formattable clipboard**

1. Open your word processing application and create a document.

2. In Time Matters, open the list containing the record from which you want to copy information.

3. Tag the record.

4. Click the Process button on the list toolbar and select Copy to Clipboard. The Clipboard Format window opens.

5. Double-click the Formattable Clipboard format that you want to use.

6. In the word processing application, click in a blank area of the document and press CTRL+V to paste the copied text into the document.
Design a formattable clipboard

1. Launch Time Matters.
2. Expand the File menu, and then select Setup, then Templates, then Formattable Clipboard.
3. In the Record Type field, select the record type from which the majority of the information will be pulled.

4. Click the Add button to define content for a new clipboard.
5. Select the access level on the Add New Clipboard popup; Program Level or User Level. Click OK to save your changes.
6. The Add Clipboard Format <selected record type> form displays. Enter a clipboard name in the Description field.

7. Select a font in the Font field.
8. The fields listed on the right are specific to the type of list chosen previously. Double-click a field from the list to move it to the body of the clipboard.

9. Once the entries are complete, the content can be previewed by clicking the Preview button.

10. Once in preview, do NOT click Cancel to get out of your preview. Click the Define tab to get back to the Formattable clipboard.

11. To specify more advanced options, click the Options tab.

12. The Clipboard Options window displays. To specify that blank lines are not printed when a data field is blank, click to check Remove Blank Lines if all Data Fields are blank.

13. To be prompted if a data field is blank, go to the Field Options portion of the window. A list of the fields that will be included on your label is available. Click Never, Always, or If Blank to be prompted before the label is printed. This is a safeguard that notifies the user that data is needed in a field so that the data can be entered before the label is printed.

14. To ensure that the information is not only used for the label, but also becomes part of the record, click to check the Backfill box for any field that is appropriate. Click OK to save your changes on the Clipboard Options window.

15. When entering the body of information, note that the tab key cannot be used. To insert a tab, insert a TAB field under Special Codes. In addition, it is sometimes a good idea to include a page break at the end of the clipboard, if multiple pages must be printed ultimately. Both TAB and PAGEBREAK are found under special codes. Special codes are displayed by clicking the Special button.

16. Click Save & Close to save your clipboard.
Create a new version of an existing document

1. Launch Time Matters.
2. Click the Docs icon on the main toolbar to open a Document list.
3. Double-click to select and open a document form for the document record.
5. Click the New Version button to create a new version.
6. The document opens. Make the desired changes to the document.
7. Save your changes. Close the document when you are ready.
8. In Time Matters, Save & Close the document record form. The next time the record is opened, it will show your updated version of the document as the current version to be accessed via the GoTo button.
Communications

View your email

Each Time Matters user has a personal inbox for email sent to that user’s account.

- Click the Mail menu, and then click Personal Inbox.

  The Inbox opens, displaying email received by your Time Matters email account.

Create and send email

1. Open your Personal Inbox.
2. Click the New button on the Inbox toolbar. An Email record form opens.
3. Complete the Subject line.
4. If this email is regarding a Matter or Contact, enter that Matter or Contact on the Regarding line.

   The Regarding line has four fields: Matter Reference, Matter Number, Client name, and Client Number.
   a. Click in the field you want to use to complete the Regarding line.
   b. Click the Lookup button ( ) at the end of the Regarding line. A list of Matters or Contacts (depending on which field you clicked on the Regarding line) opens.
   c. Locate the Matter or Contact in the lookup list, highlight it and click the Select button. The Regarding line is completed.
5. In the To field, type the email address to which you want to send the email. You can also click the Lookup button ( ) beside the To field to select from a list of Contacts, Time Matters Staff, and distribution lists.
6. In the Message area, type the message you want to send.
7. If you want to attach a file to the email, click the Attachment button, then click the Add button that displays, and browse to the file you want to attach.
8. Click the Send button on the Email form toolbar when you are ready to send the email.
Send instant messages to other Time Matters users

1. Click the View menu and then click Messenger Window. The Messenger opens.
2. Click the Add button. A Message form opens.
3. Click the Lookup button ( ) beside the To field to select the Time Matters user you want to send a message to.
4. Type your message in the Message area.
5. To flag the message as urgent, click the Urgent button.
6. Click Send when you are ready to send the message.

Create a phone record

Phone records keep track of both outgoing and incoming calls.

1. To create a phone record, launch Time Matters.
2. Expand the File menu, and then select New Record, then Phone Call.
3. The Phone Call form opens.
4. The Date and Time fields are required and will be pre-populated with the current date and time although the fields may be changed to a date you prefer.
5. Select, or enter, a classification code in the Code field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected.
6. Enter the reason for the phone call in the Subject field.
7. Enter the staff to be associated with the phone call in the **Staff** field. Staff can be selected from the drop down list or by using the lookup button. The first staff selected will be the primary staff person associated with the phone call in Time Matters.

8. There are 4 pieces of information to be completed as part of the **Regarding** field. This set of information also appears on the Event, ToDo, and Supporting Forms. The Contact form has Matter Reference and Matter Number fields. The Matter form has Client and client Number fields. Completing this information is important to maintain relationships in the database. Also, completing these fields causes the record to appear on the Timeline Tab on the Contact and Matter records. There is a lookup button provided to help in completing these fields.

9. Complete the rest of the form as appropriate for the record being created.

10. **Save** your changes.
Reports

Print a standard report

1. Launch Time Matters.

2. Expand the Report menu, and then select Standard Reports.

3. The Standard Reports window displays. Select the tab that is related to the report to be printed; Billing, Transactions, Tax, Staff, or Setup.

4. Select the report level; Program and User Level, Program Level, or User Level.

5. Select a report Name.

6. Select a report Format. Remember to edit the format using the Filter and Options tabs.

7. Click the Printer button.

Export information to an Excel spreadsheet

1. Launch Time Matters.

2. Display the type of list you are looking for; e.g. contacts.

3. If only specific columns are to be included in the exported data, edit the list display before exporting to Excel. To do that, right-click in the list toolbar, and select Edit Columns on the popup list.
4. A popup window, which shows all possible fields associated with the list, will display. Manipulate the fields until only the fields to be exported are in the right box titled “In List.” Arrange the fields in the order you want by using the Up and Down buttons. Click the OK button to save your changes.

5. If only a subset of data records are to be included in the exported data, use the Search function to filter for the records you want to see. This will allow you to filter based on a set of criteria that you select. Highlight the criteria, and a popup window for that criterion will be displayed. Use the drop down menu, or lookup button, to select the criteria you need. Click OK to save your changes. Select as many criteria as needed. The changes only affect your view of the data, and do not change the data that are actually stored.

6. Click the Send to Excel button. (If the Send to Excel button is not displayed, see Customize a Time Matters list.)

7. This will export everything, including all columns, to an Excel spreadsheet.

8. To save a copy of the spreadsheet to Time Matters, click the TM Save button.

9. A Document Form will display. Fill in the form as appropriate, and save the document to one of your cases.
Save a tagged list

1. Launch Time Matters.

2. Open a list where you want to easily work with a subset of the records; for example, contacts. The Contacts list can be opened by clicking the Contacts icon on the Time Matters main toolbar.

3. Tag selected records on the list by clicking to check to the left of their record.

4. Click the **Process Records** drop down menu button.

5. Select **Save Tagged** from the drop down menu.

6. The **Saved Tag Records List** window displays. Click the **Add** button to add a new list.

7. The Saved Tag List Name window displays. Enter a name for the new list in the Name field. Click **Ok** to save your changes. The new list of tagged records is now displayed in the tagged records lists.

8. As new records are added to the list, you may want to add them to the saved list. To do that, display the list, click the Process Records button, and select **Save Tagged**. Highlight the list where you want to add the new tagged records, and click the **Save** button. You will be prompted to Replace the Tag List or Add to the Tag List. Select **Add to Tag List** if you have only tagged the records to be added. Click **Ok** to save your changes.

9. At a late time when the tagged list is needed, display the list, then click the Process Records button. Select **Save tagged**.

10. The **Saved Tag Records List** window displays. Double-click the list that you saved.

11. The records on the saved list are tagged automatically.
Design a report

1. Launch Time Matters.
2. Go to the list of the type of data for which you want to create a report. For example, to design a report for Matters, click the Matters icon on the main toolbar.
3. To access the Report Designer from the select list, in this case, Matters; click the Print Records icon on the list toolbar.
4. The Report Specifications form displays. Note that some basic formats are displayed in the box on the right side. To create a new report format, click the Add button under the list of formats to define the format of the new report.

![Report Properties popup](image)

6. If the default font to be used in the report is not acceptable, click the Set Font button. A popup window allows you to change the font. Click OK to save your changes and the font select popup closes.
7. Change the size of the paper to be used, if the report will be printed, and select the margin size on the Page tab of the Report Properties box.
8. The Sort tab is used to sort the information in the report. Select the first, second, and third fields on which to sort the report data. Select Ascending or Descending order. The Subtotal Band box is useful in two cases; to include subtotals in Billing reports, and also to eliminate duplication of a column name. Be sure to save your work before attempting to add a Subtotal Band data field.
9. Once the report properties are selected, click OK to save your changes and the Report Properties popup closes.
10. The buttons at the top of the Report Designer window are used to set up how the report will look.

11. The center section of the Report Designer is used to specify what type of data will appear in the Header, Detail, and Footer, and how it will be formatted. The Header is typically used for a report title, date, name of the individual who printed the report, or the columns to be included. The Detail usually includes the actual data in the report. The Footer is not required, but if you want to include items such as a page number, that can be specified in the footer. The size of these sections can be changed by hovering over the separator until the cursor becomes an up-down arrow and dragging the separator up or down.

12. The list on the right changes based on the selection made in the drop down box beside the column name. The list can be Data Fields, Field Labels, or Special. Data Fields specify data associated with the record, Field Labels are field names that are used in the created reports, and Special items are related to formatting or fields that were set up specifically by your firm’s administrator.

13. To enter a report title, click the Insert Text icon in the Report Designer toolbar, then click anywhere in the Header section. Note that the Header bar highlights automatically to let you know you are in the Header section.
14. A **Text Data Field Properties** window displays. Under the **General** tab, enter the title that you want to use for the new report in the Text box. If you want to change the font of the title text, click the **Set Font** button.

15. If you know the X and Y coordinates where you want the title to be displayed, specify those using the **Positioning** tab of the Text Data Field Properties window.

16. Set the alignment for the **Title** in the **Alignment** field.

17. Click to check **Wrap Text** if it is acceptable for the title to wrap across multiple lines.

18. Click **OK** to save your changes.

19. To see the title you specified, click and hold the handles on the text box to stretch the box as you increase or decrease the size of the text box, if necessary. The field can be dragged to another location in the Header using the mouse, but cannot be moved to the Detail or Footer sections.
20. To add a Special, pre-defined field, such as the Date, change the list on the right to Special. Double-click on the item to be copied (in this case, the variable {TODAY}). Notice that the cursor changes to a piece of paper once you double-click on the variable TODAY. Click in the section of the report; Header, Detail, or Footer, where the field must be located. The field displays in the correct report section.

21. In designing the report, you can use existing field labels, or create your own. To use existing field labels, change the right list to Field Labels. Again, double-click the field label in the list, and click in the section of the report where you want the field label to be located. Once the Field Labels are located correctly, drag the size of the box around each Field Label to a size sufficient to display all of the data that will be in the field. Otherwise, the data will be cut off in the report.

22. To define a field label rather than use a default label, click the Text Box icon and define your own label similarly to how the title was created.

23. If additional formatting is needed, right-click in the Field Label box and change the Field Label Properties as needed.

24. To align fields within a report section, place one of the field labels correctly. This becomes the master field for this alignment exercise. Hold down the CTRL button, and click inside each of the labels to be aligned with the master field. Click inside the correctly placed field last. The field that will be used as the master has red handles, while the other fields have blue handles. Expand the Edit menu, and select the alignment to be made.

25. To define the fields that the data will be pulled from, change the list to Data Fields. Double-click the data fields to be displayed and then click in the Details section. Stretch the data labels so that the data displayed in the report will not be cut off.

26. Use the same method to align the data fields that you used to align the field labels in the header.
27. To align data across multiple sections, such as a field column name with the data to be displayed in the column, click in the ruler at the top of the Report Designer. A guideline will appear. Click on the guideline anywhere other than inside the ruler, and holding down the cursor, move the guideline until the targeted field ‘locks’ onto the guideline, then move the guideline as needed. When the fields are located correctly, click on the guideline in the ruler and the guideline disappears.

28. Consider dragging the Detail separator closer to the data fields to reduce the amount of white space between lines of data in the report.

29. Define the data to be displayed in the Footer using the same technique used for the Header.

30. Click the Save & Close icon in the report designer toolbar to save your changes and close the report designer.
31. The new report format appears now in the list of report formats that can be used.

32. With the newly created report highlighted, click the **Preview** button.

33. The report that was just designed displays. If data is cut off, simply return to the Report Designer and stretch the field boxes as described earlier.

34. Use the **Options** tab to define how the report format will be sorted. The sorting options vary depending on the Record Type selected.

35. Use the **Filter** tab to specify any data filters that will be used when reporting using the selected format.

36. Use the **Additional** tab to include other records in the report.

37. Continue to edit the report, using the Report Designer, until the report is satisfactory.
Edit a report

1. Launch Time Matters.
2. Click the Reports icon in the main toolbar.
3. The Report Specifications window opens. Highlight the report to be changed.

4. Click the Change button. The Report Designer information for the selected format are displayed.
5. Edit the report properties using the same techniques used to create the report.
6. Save & Close the report designer. Click the Preview button on the Report Specifications window to view the report with the changes included.
7. The report can be edited as often as necessary.
Print labels

1. Launch Time Matters.
2. Click the Reports icon in the main toolbar.
3. The Report Specifications window opens. Select the record type for which you want to print labels.
4. Highlight the Label tab.
5. Click the Add button under the right box.
6. The Label Format window displays. Enter a name for your new label list in the Description field.
7. Select a **Label Group**. For most users, this will be an inkjet or laser selection.

8. Select a **Label Layout**. The menu items will be displayed once a Label Group is selected. The selectable list is based on the Avery standard. When you purchase your labels, the type of label address standard to use is usually included. This determines how many labels of what size will be printed.

9. The box on the left will contain your designed label once you complete this process.

10. The list on the right contains **Data Fields** or **Special fields**. To select either, click the pull down menu.

11. Click in the blank box in the bottom left portion of the window to start creating the label. Double-click the first field to be included on the label from the **Data Fields** or **Special** drop down list on the right. Manually insert spaces and blank lines between data items.

12. Select a **Form Style** if appropriate.

13. To change the font, highlight the text in the label box to be changed, and then click the **Font** tab. Select the font to be used, and when finished, click **OK** to save your changes.

14. To specify more advanced options, click the **Options** tab.

15. The **Label Options** window displays. To specify that blank lines are not printed when a data field is blank, click to check **Remove Blank Lines if all Data Fields are blank**.

16. To include a barcode in the label, click to check **Print POSTNET Barcode**. In order to qualify for a rate for bulk mail, this barcode must be included, although it does not guarantee the reduced rate. If checked, select a zip code and street address in the POSTNET Options.

17. To be prompted if a data field is blank to determine what to print, go to the **Field Options** portion of the window. A list of the fields that will be included on your label is available. Click **Never**, **Always**, or **If Blank** to be prompted before the label is printed. This is a safeguard that notifies the user that data is needed in a field so that the data can be entered before the label is printed.
18. To ensure that the information is not only used for the label, but also becomes part of the record, click to check the Backfill box for any field that is appropriate.

19. Click OK to save your changes.

20. On the Report Specifications window, use the Start at Label Number field under the Options tab to tell Time Matters what the first label number is for printing. This allows you to use partial label sheets and decreases the likelihood of wasting labels.

21. Use the Filter tab to define what data to use when printing labels. Filter can only be used if running a list without tags.

22. Select Close when the label is designed.
Print envelopes

1. Launch Time Matters.
2. Click the Reports icon in the main toolbar.
3. The Report Specifications window opens. Select the record type for which you want to print envelopes.

4. Highlight the Envelope tab.
5. Click the Add button under the right box.
6. The Label Format window displays. Enter a name for your new label list in the **Description** field.

7. Select an Envelope Layout from the **Envelope** list.

8. The box on the left will contain your designed label once you complete this process. The list on the right contains **Data Fields** or **Special** fields. To select either, click the pull down menu.

9. Click in the blank box in the bottom left portion of the window to start creating the label. Double-click the first field to be included on the label from the **Data Fields** or **Special** drop down list on the right. Manually insert spaces and blank lines between data items.

10. Select a **Form Style** if appropriate.

11. Click **OK** to save your new envelope format.
Time & Expense

Create a timesheet

A timesheet is for entering time and expenses on an on-going basis. An entry will display on the timesheet if it matches the selected week and staff.

1. Launch Time Matters.
2. Expand the Billing menu, and then select Timesheet.
3. Click the Add button on the timesheet list.
4. A billing form displays. Note that the Date and Time fields are populated with the current date and time. Click the lookup button beside either of these fields to change the date or time.

5. Select, or enter, a classification code in the Code field. If you want to select multiple classification codes, use the lookup button. A maximum of 5 codes can be selected.

6. Enter a description in the Description field.

7. Select a staff member in the Staff field.

8. There are 4 pieces of information to be completed as part of the Regarding field. This set of information also appears on the Event, ToDo, and Supporting Forms. The Contact form has Matter Reference and Matter Number fields. The Matter form has Client and client Number fields. Completing this information is important to maintain relationships in the database. Also, completing these fields causes the record to appear on the Timeline Tab on the Contact and Matter records.

9. Save your changes.

10. Note that the new information appears on the timesheet form.
Billing

Set up basic billing

1. Click the File menu, point to Setup, then point to General, and then click Program Level.
2. Click the Links tab and the Billing subtab. (If the Billing subtab does not appear, click the main Billing tab and ensure that the Activate Billing Matters check box is not checked.)
3. Click the Activate Billing check box.
4. Select Basic Billing in the Select Billing Link drop-down list.
5. Click the Set Billing Options button. The Time Matters Billing Setup window opens.
6. Set options on the General tab:
   a. Select whether to bill by Contacts, Matters, or Contacts and Matters.
   b. Type the number to use for the first (or next) invoice you create in the Next Invoice Number box.
   c. Select Allow changes to Billing Form if you want to enable customization of Billing forms.
   d. Select Allow Time Matters Records to be billed more than once if you will allow records to be billed multiple times.
   e. Select Allow Billed Records to be on more than one Time Matters Invoice if you will allow billed records to show on more than one invoice.
7. Click the Rates tab to add or modify rate tables.
8. Click the Setup tab to modify additional billing options, such as setting a global rate for your business, a default billing basis, and a default rate level.
9. Click the Address tab to select the fields used to complete the Bill To area of invoices.
10. Click OK to close the Time Matters Billing Setup window.
11. Click OK to save your changes and close the Program Level Setup window.
12. To activate billing for each user that will need access to the billing functions, go to File > Setup > General > User Level.
13. Select a user from the drop-down list in the top left corner of the User Level Setup window.
14. Click the Links tab and the Billing subtab.
15. Select the Activate Billing check box and click the Set Billing Options button. The Time Matters Billing Link Options window opens.
16. Select whether to use Program Level settings or to specify individual user settings for the available options.
17. Click OK to close the Time Matters Billing Link Options window.
18. Click OK to save your changes and close the User Level Setup window.
Add and print an invoice

1. Launch Time Matters.
2. Expand the Billing menu, and then select Invoice List.
3. The invoice list displays.
4. Click the Add Record button.
5. An invoice form opens. If billing by contacts, select a contact for the **Regarding** field. If billing by Matter or Contact-Matter, or with Matter as a default, select a Matter for the **Regarding** field.

6. Billing Address will complete automatically when a contact or Matter is selected in the **Regarding** field. Shipping Address may be completed manually and is not necessarily the same at the billing address.

7. In Invoice settings, enter the date for the invoice in the **Invoice Date** field.

8. Select the Terms in the **Terms** field to apply to this invoice.

9. Enter the due date for payment of this invoice in the **Due Date** field.

10. Enter the purchase order number, if required, in the **P.O. Number** field.

11. In the Invoice Details area, enter the **Invoice Number**. Note that this field may be grayed out depending on how your administrator set up billing for your firm.

12. Select the **To be Printed** check box if the invoice is to be printed at a future date.

13. In the **Invoice Items** area, add billing items to the invoice in 2 ways; the first method is to type them directly. The second method is to click the **Add Billing items** button to open the Billing Item List.

14. To print the invoice immediately once it’s complete, click **Print**.

15. Click **Save & New** to save this invoice and open a new one, or finally, click **Save & Close** to save this invoice and close the window.
Print multiple invoices

1. Launch Time Matters.
2. Expand the Billing menu, and then select Invoice List.
3. The invoice list displays.
4. Click the checkbox to tag the items to be printed.
5. Click the Print button on the toolbar to print the selected invoices.

Print a pre-bill from the Billing menu

1. Launch Time Matters.
2. Expand the Billing menu, and then select Print Pre-bills.
3. The Print Pre-Bills screen displays.
4. If applicable, set up a filter to draw the required matter records using the Matter tab.
5. If applicable, set up a filter defining how work-in-progress will be filtered using the Charges & AR tab.
6. Use the **Options** tab to broaden or narrow the filter of items for which pre-bills will be printed.

7. Use the **Include** tab to define information that must not be printed on the bill.

8. Click **Print**. The printed copies can be distributed for review.

**Create a bill**

1. Launch Time Matters.

2. Expand the **Billing** menu, and then select **Create Bills**.

3. The create bills window opens.

4. On the **Matter** or **Contact** tab, find the client records that are ready for billing.

5. On the **Charges & AR** tab, complete the required information specific to work in progress. This information acts as an additional filter after the matter filter has been applied.

6. On the **Options** tab, broaden or narrow the filter further.

**Post/undo a bill**

1. Launch Time Matters.

2. Expand the **Billing** menu, and then select **Post or Undo**.

3. The **Post or Undo Bills** window lists the bills that have been created but not yet posted.

4. There are two choices available from this screen; post bills if they have been reviewed for accuracy, or undo a bill so that it can be re-created at a later time.
Receive a payment

1. Launch Time Matters.
2. Expand the Billing menu, and then select New Transaction, then Payment.
3. The Transaction Entry screen displays.

4. Select Payment as the type of transaction.
5. Select a bank account in the Account field.
6. Auto Allocate allocates payment according to the client’s billing preferences. This is recommended.
7. Select Multiple Matters if one payment is to be used for paying bills for multiple Matters.
8. In the Payment Information section, enter who the payment is from, date received, payment method, amount, and credit card or check number. An optional memo can be included.
9. In the Payment For section, to have the matter info entered automatically start entering and will autofill, or enter the invoice number.
10. If there are multiple outstanding invoices for the matter, they will be displayed in the invoices list.
11. If entering an invoice number first, a list of any outstanding invoices with that number will display. Select the invoices to be paid.
12. Click Save & New to save this invoice and open a new one, or finally, click Save & Close to save this invoice and close the window.
Record a bank deposit

1. Launch Time Matters.

2. Expand the Billing menu, and then select New Transaction, then Bank Deposit.

3. Select Bank Deposit as the type of transaction.

4. Select a bank account in the Account field.

5. Enter the basic info in the Deposit Information fields.

6. Payments and Credits made to the selected account are listed in the lower half of the Transaction screen.

7. Click Save & New to save this invoice and open a new one, or finally, click Save & Close to save this invoice and close the window.
User Preferences

Set user preferences

Most of your preference settings are accessible on the User Level Setup screen.

To open User Level Setup:

- Click the File menu, then point to Setup, then point to General, and then click User Level.

A few of the preferences you can set on this screen include:

- Customizing the main Time Matters toolbar
- Customizing the toolbar of a record list
- Enabling and disabling wizards
Enable or Disable the Wizard

Wizards (tools to streamline data entry) are available for many common tasks. As you become more comfortable with Time Matters, you may want to disable a wizard and enter data directly on a form.

1. To enable or disable a wizard, start Time Matters.
2. Click the File menu, and then click Setup, then General, then User Level.
3. In the Wizard Defaults area, select or clear the check box to enable or disable any of the listed wizards.

Customize the Time Matters main toolbar

The icons that are displayed on your main Time Matters toolbar can be changed. Once you have set up the view that you prefer, that view will be displayed for you any time you log into Time Matters on any workstation.

1. Launch Time Matters.
2. Right-click in the main toolbar.
3. Click Customize in the popup window.
4. The **User Level Setup** popup window displays. On this window you can set up several options for **Time Matters**. First, select a user in the **Select a User** drop down menu.

5. To determine the look of your toolbar, select the correct toolbar in the **Select Toolbar** field.

6. The items that appear on your toolbar are in the list of options on the right. If there is an item in the list on the left that you would like to see on your toolbar, highlight the item on the left side menu. Click the **Add** button and the item appears in the list on the right.

7. Similarly, if you want to move an item up or down in priority on your toolbar, highlight the item in the list on the right. Click the **Up** or **Down** button.

8. Use the **Preview** button to see how your toolbar will look with your changes. To add some space between buttons, select **Separator** and place it between items on the toolbar.

9. If you want to display many buttons, more than one toolbar can be displayed by using the **Lookup** button.

10. The **Toolbars** window displays. Click the **Add** button and name the new toolbar.

11. Click the **OK** button to save your new toolbar.
12. Click **OK** on the User Level Setup window to save your changes.

13. If you set up multiple toolbars, but do not want to see all of them all the time, right-click anywhere in the toolbar and uncheck the toolbar that you do not want to see.

**Customize a Time Matters list toolbar**

1. Start Time Matters.

2. Select a list, such as contacts, or Matters. For example, to select the Contacts list, click the Contacts icon in the main toolbar.

3. Click the **Options** button on the list toolbar.

4. The User List Options window displays. Select the List Toolbar tab.

5. The items that appear on your toolbar are in the list of options on the right. If there is an item in the list on the left that you would like to see on your toolbar, highlight the item on the left side menu. Click the **Add** button and the item appears in the list on the right.

6. Similarly, if you want to move an item up or down in priority on your toolbar, highlight the item in the list on the right. Click the **Up** or **Down** button.

7. Click **OK** to save your changes.